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What is the Classical Text Editor?
Classical Text Editor is a word-processor written for the special needs of scientific editions.

It contains facilities for working with critical apparatus and sigla.

Several apparatus and sets of notes can be defined. The indexing and referencing as well as the making 
up will be done by Classical Text Editor. Each apparatus or set of notes may be referenced through 
repetition of words contained in the text, as usual with critical apparatus, or through footnotes.

Classical Text Editor allows the text, along with the margins and the alignment, to be mirrored in a 
sophisticated way. It fully supports right-to-left text. Classical Text Editor lets you create any number of 
indices.

Windows 95/NT only: You may include objects such as graphics (by linking or embedding) in a Classical 
Text Editor document, which were created by another application, if that application supports OLE.

When using block align, if you don't want the superfluous space to be equally distributed between all 
words you can define positions in the text where it shall be inserted.

For each document there is a text window, a header and footer window and one window for each 
apparatus or notes.

Classical Text Editor uses True Type™ fonts only.

See also: Introduction and First Steps



Introduction and First Steps
Creating a Classical Text Editor document
Create a new document by executing New from the File menu, or import an existing document in Rich 
Text Format by choosing Import from the File menu. Then invoke the Format Dialog by executing Format 
from the Options menu to set the page format, the numbers of notes and apparatus you need, their styles 
and preferences, the margin formats, etc. Of course, you may change any of these preferences later.

Editing
You can edit the text in two modes, between which you can change with Edit Mode and Made Up Mode 
in the Options menu. The edit mode allows you to use the whole window space and to edit margin text 
and text formatted as hidden. In made up mode you can do the syllable division.

To highlight parts of the text (in fact, the color will be inverted), either press the Shift key when using the 
keys for cursor movement, or press the mouse button at one end of the text to be marked and release it 
at the other end, or set the caret to one end and click at the other end while pressing the Shift key. Mark 
whole words by double-clicking them, whole paragraphs by double-clicking while pressing the Shift key.

There are four bookmarks you may use to navigate through your text. Set them by pressing Shift, 
Control and the corresponding number key (1 to 4). Return to your mark in whichever window by pressing
the Control key plus the number key.

If, e. g. after an operation involving the repositioning of paragraphs, the screen should not be updated 
properly, use the Windows menu's Refresh command or press F8.

See also: Special Characters

Updating the References
While editing the text window, changes that concern the apparatus and notes are monitored. References 
that seem no longer valid are marked with a ‡ sign and can be found (Shift + F9 or Find|Find Dirty) and 
updated later.

The footnote numbers, index and line numbers of the references in notes and apparatus are NOT 
updated on the fly. So before printing your document you should execute Update All References from the 
Edit menu.

Recommendations for Quick and Easy Work
Try to constitute your text before adding notes and apparatus. This will save you the time to update all the
obsolete references.
When you begin to work with a text, e.g. when you import it from a RTF-file, start with chapters and 
margins. Working with a document will get much faster, when chapter or margin texts appear from time to 
time in the text. If you don't need either of them, insert some empty margin text blocks.
When editing a text for which notes and/or apparatus have already been entered, don't switch much 
between the text window and other windows of the same document. Every time you do so, all the 
changes you made in the text window will have to be applied to all notes and apparatus (regardless if 
visible). That's just wasting time and nerves.
When adding new notes or apparatus entries, work whenever possible with just one note and/or one 
apparatus window open. So you won't have to specify each time you make a new entry the number of the
window into which it shall be made.
If you use numbered footnotes, it may be preferable to enter them before you enter the apparatus. This is 
simply because footnote numbers cause a change of the text which makes it necessary to update the 
apparatus.
Disable kerning for screen output, especially if you use italics. Thus the screen will be updated faster and
you will avoid eventual partially overwritten italic characters.



Create and use Autotext   shortcuts   for frequently repeated text.

Above All
SAVE YOUR DOCUMENT ALL TEN TO TWENTY MINUTES !    It's just pressing Ctrl+S. Every time you 
save, the last version will be conserved in a backup file, which takes the file name and the extension 
".~ct". If your document should get corrupted: Quit without saving, delete the document and rename the 
backup file by giving it the extension ".cte".

BACKUP YOUR WORK EVERY EVENING (or morning, depending on the time you use to turn off your 
computer). Don't let the file you work on be the only you got. Your hard disk might crash or even you 
might do something quite unexpected to your file and save twice so the backup file would be gone, too.

See also: Sigla and Manuscripts      Indices      Text      Header     and     Footer        Notes      Apparatus



System Requirements
Environment: 16-bit version: Microsoft Windows™ 3.1 or compatible

32-Bit version Microsoft Windows™ 95 or NT
Classical Text Editor has not been tested with Microsoft 
Windows™ 32s

Processor: At least 80386; 80486 or higher recommended
Disk space: 3 MB plus three times the size of currently open documents.
At least one True Type™ font installed.
The installation of MultiKey is recommended.



Text Window
This window contains the main text.

References
To create a reference to a certain part of the text, mark it and choose from the Insert menu either 
Apparatus Reference (F5) or Note Reference (Shift + F5). The reference will be inserted into the currently
open window of the specified type and that window will get active. If the chosen apparatus / notes 
contains footnotes instead of text references, a footnote will be inserted at the caret position.
References will cover whole words only. So your marking has in no way to be exact, just cover any part of
the first and the last word. If you want to reference just one word, it is sufficient to place the caret there. If 
the reference is obvious from the context, you may hide it using the Reference Flag dialog. If the same 
word should occur more than once in a line and therefore indexing should get necessary, the reference 
will become visible again automatically (and be hidden again if indexing is no longer necessary). Do not 
hide a reference using the Hidden font style except if, in certain cases, you want to specify the reference 
manually. This may be useful if a change of font should be inevitable.
Besides those necessary references that connect your notes with the text, it is possible to create 
references to lines of text. To do so, set the caret in the notes / apparatus window to the position where 
the reference shall be inserted, then change to the text window again and posit the caret on that word 
whose line shall be referenced and choose Line ref. to app. (F7) or Line ref. to notes (Shift + F7) from the 
Insert menu. The new reference will be inserted and in the following updated with the other references. 
References that point to the same line as the entry in which they are found will not be printed but shown 
in edit mode as asterisks (*), formatted as hidden.
If you insert a space (or paragraph break) in the middle of a referenced word and thus divide it into two 
words, the reference will henceforth point to the second word. Spaces and paragraph signs themselves 
are treated as belonging to the word which precedes them. So in most cases it will be more useful to 
insert new spaces before, not after a word.

Chapters
Chapter numbers will be used for referencing in headers, footers, apparatus and notes and for line 
numbering. To create them, type the number (or string), mark it and choose Chapter from the Insert 
menu.
If you don't want the chapter number to be printed in the text just in the form you want it to be used in 
references, change its format to hidden. If you want just the line numbers, specify a single space 
character.
The line in which a text marked as chapter text is found will be numbered as the first line of the chapter.

Margins
At any place of your text you can enter text to be displayed at the margins. Choose Inner Margin or  Outer
Margin from the Insert menu (Be sure the window is in Edit mode). Type the margin text in the colored 
part of the text. Margin text that fits into a single line will not interfere with line numbering; line numbers 
will be skipped. If you define longer margin text, it is on you to prevent single instances of margin text 
from interfering with each other and with line numbering.



Header and Footer Window
This window contains the headers and footers for each section in the following order:

Left Header
Right Header
Left Footer
Right Footer

To insert a reference to the chapters shown at the current page (or double page), choose Note Reference 
from the Insert menu.



Apparatus Window
This window contains an apparatus. Each paragraph corresponds to one entry.    Nevertheless, on printing
all entries belonging to the same page will be gathered into a single paragraph. An empty paragraph will 
show up as a paragraph break in the printout.
Every number will be interpreted as a manuscript identifier. To insert numbers that are no manuscript 
identifiers, use the Alt Key in combination with the numeric keys.
To insert a siglum, choose Siglum… from the Insert menu or press F3.
To find an entry whose corresponding part of the text has changed, choose Dirty Reference from the Find 
menu or press Shift + F9. The text window's, if open, caret position will be synchronized.
To update a reference right now and eventually clean the ‡ sign, choose Clean Reference from the Edit 
menu or press F9.

It is not recommended to format whole entries as hidden. Doing so will cause difficulties in the print-out: 
Line references preceding a hidden entry will themselves be hidden. If you override this by setting the 
references format to definitely not hidden, all line references will show up, but this can lead to "empty" 
references, if no visible entry applies to this line.
Solution: If you don't want to delete entries not needed for printing, create a new apparatus not intended 
for printing and move these entries there (Using copy and paste).

See also: Sigla and Manuscripts.



Notes Window
This window contains notes on the text. Each paragraph corresponds to one entry.    Nevertheless, on 
printing all entries belonging to the same page will be gathered into a single paragraph. An empty 
paragraph will show up as a paragraph break in the printout.
To find an entry whose corresponding part of the text has changed, choose Find Dirty from the Find menu
or press F2.
To update a reference right now and eventually clean the ‡ sign, choose Clean Reference from the Edit 
menu or press F9.



Print Window
This window shows the text as it will be printed.
Use the scroll-bars or the arrow keys to view different parts of the page (Windows 3.1 version: Only the 
keys on the numeric keyboard with NUMLOCK set to on will work). Use these keys in combination with 
the Ctrl key to scroll by page.
Use the Page Down key or the arrow down button to get the next page.
Use the Page Up key or the arrow up button to get the previous page.
You can zoom in or out using the Windows menu's Zoom command.



Dialog Boxes
Apparatus / Notes Settings
Delete Mss.
Edit Sigla
Edit Autotext
Find
Find Mss.
Find Sigla
Font
Footnote Style
Format
Import Bible Works text
Import File
Index
Insert File
Insert Chapter Reference
Insert Special Character
Open File
MultiKey
Paragraph
Paragraph Numbers
Preferences
Reference Flags
Registration
Replace
Scale Object
Section
Sigla
Zoom

About



Menu
File    Edit    Insert    Find    Options Windows    Object    Help

File
New Creates a new document.
Open… Lets you open an existing document.
Import… Lets you import a file in the ENPS or RTF format.
Save Saves the current document.
Save as… Lets you save the current document under a new name.
Close Closes the current document.
Print… Displays the Print dialog box to let you print the current document.
Print preview Shows the current document as it will be printed.
Printer setup… Displays the Printer Setup dialog box.
Exit Exits Classical Text Editor

Edit
Font… Lets you change the current font.
Paragraph… Lets you change the attributes of the current paragraph.
Section… Lets you change the attributes of the current section.
Reference… Lets you change the attributes of the current reference or footnote.
Delete reference Deletes the current reference.
Clean reference Clears the "Dirty" sign from the current reference.
Update all references Updates all references
Sigla

Solve next block Solves the sigla of the manuscript numbers / sigla block right to the caret to 
manuscript numbers.

Build next block Builds the manuscript numbers / sigla block right to the caret to sigla.
Solve all Solves all sigla of the current document to manuscript numbers.
Build all Builds all manuscript numbers of the current document to sigla, where 

possible.
Create Autotext... Define Autotext shortcut for marked text.

Insert
Apparatus reference and
Note reference A) In the text window, adds a reference to the currently selected words to 

(one of) the open apparatus / note window(s).
B) In the header / footer window, inserts a reference to the current chapter

Line ref. into apparatus Inserts a reference to the caret position in the text window into (one of) the 
open apparatus window(s). This function is intended to create cross-
references. It will not bind a part of the apparatus to a certain location of the 
text.

Line ref. into notes Inserts a reference to the caret position in the text window into (one of) the 
open note window(s). This function is intended to create cross-references. It 
will not bind a note to a certain location of the text.

Siglum… Lets you insert a siglum
Chapter Marks the selected text as a chapter definition.
Inner margin Lets you insert inner (left) margin text.
Outer margin Lets you insert outer (right) margin text.
Command string... Lets you insert a command string (for indices)
Paragraph numbers… Lets you add nunbered chapter and margin text to paragraphs automatically.
Character map Opens a window displaying the characters of the current font.
Special character... Lets you insert dashes, syllable divisions etc.
Section… Inserts a section separator at the end of the current paragraph.
File… Lets you insert another Classical Text Editor document into the current one.
Autotext Change Autotext shortcut to the associated text.
Bible Works text Insert converted Bible Works Greek or Hebrew text at the caret position.



Find
Find… Lets you search for text and formats.
Replace… Lets you search and replace text and formats.
Find again Repeats the last search operation without opening the Find window.
Replace again Replaces found text without opening the Replace window.
Find mss.… Lets you search for a ms. or a constellation of mss.
Find mss. again Repeats the last Find mss. operation.
Find sigla Lets you search for a siglum or a constellation of sigla and mss.
Find sigla. again Repeats the last Find sigla operation.
Find dirty Searches for the next not-updated reference after the caret position.
Delete mss.… Lets you delete mss. from the current document.
Bookmark Go to a bookmark.
Set bookmark Set a bookmark to the current position.

Options
Edit mode Lets you edit margin text, using the entire window.
Made up mode Shows the line breaks as they will be printed.
Show control signs Makes line breaks and other special characters visible.
Preferences… Lets you select the colors used by Classical Text Editor to distinguish 

different sections of text.
Format… Lets you specify the settings of the active document.
Sigla… Lets you add sigla to your document or change existing sigla.
Autotext  …  Dlg5020 Lets you view and modify your Autotext shortcuts.
Import

Format... Lets you import the formats of another document.
Sigla... Lets you import the sigla of another document.

Windows
Text Opens and/or display the text window of the current document.
Notes Opens and/or display the notes window of the current document. If there is 

more than one notes window, a dialog box will ask for the number.
Apparatus Opens and/or displays the apparatus window of the current document. If 

there is more than one apparatus window, a dialog box will ask for the 
number.

Header & footer Opens and/or display the header/footer window of the current document.
Tile Tiles open windows.
Cascade Arranges open windows.
Arrange icons Arranges the icons of minimized windows.
Synchronize Sets the caret position in all other windows of one project to the position that 

resembles the caret position in the active window.
Refresh Repaints the windows of the current document.
Zoom Lets you change the zoom factor of the current window.

Object (Windows 95/NT only)
New… Lets you create a new linked or embedded object.
Copy Copies the current object to the clipboard.
Paste… Lets you insert a linked or embedded object from the clipboard.
Properties… Lets you change the current object's properties.
Scale… Lets you change the size of the current object.
Open… Performs the current object's default action, which will in most cases be 

opening the object for editing.
Do Lets you choose an action associated with the current object to perform.
Update Updates the current object.

Help
Index Display the help index
Keyboard Gets help on the keyboard
Toolbar Gets help on the toolbar



Menu Gets help on the menu
Using help Gets help on Windows help
About… Displays the About dialog box



Toolbar
Use the toolbar boxes and buttons to format fonts and paragraphs without invoking dialog boxes.

Click at the graphics to get specific information.



Template Combobox
For any paragraph in the text window, you may select a template. Templates are defined in the Format 
dialog (menu: Options | Format).
If you change the template of a paragraph, the styles in which the paragraph differed from his previous 
template will be kept. If you want to discard them in order to give the paragraph exactly the styles of the 
new template, hold down the shift key while selecting the new template.



Font Combobox
Use this combobox to quickly select any desired font. Eventual highlighted text will be converted to the 
selected font.



Font Size Combobox
Use this combobox to quickly select any desired font size. Enter the size manually if it is not displayed in 
the list. Eventual highlighted text will be converted to the selected font.



MultiKey Button
If MultiKey is installed on your system, pressing this button invokes the MultiKey dialog.



Bold Button
Pressing this button toggles the font between bold and not bold.



Italic Button
Pressing this button toggles the font between italic and not italic.



Capitals Button
Pressing this button toggles the font between capitals and not capitals.



Underline Button
Pressing this button toggles the font between underline and not underline.



Strikeout Button
Pressing this button toggles the font between strikeout and not strikeout.



Hidden Button
Pressing this button toggles the font between hidden and not hidden.



Right-to-Left Button
Pressing this button toggles the font between right-to-left and left-to-right writing.



Left-Align Button
This button left-aligns the current paragraph.



Right-Align Button
This button right-aligns the current paragraph.



Center Button
This button centers the current paragraph.



Block-Align Button
This button block-aligns the current paragraph.



Control Signs Button
This button toggles the visibility of control characters such as paragraph signs.



Synchronize Button
Pressing this button synchronizes the caret position of each window of the active document according to 
the caret position of the active window.



Sigla Combobox
If an apparatus window is active, this combobox lets you choose a siglum to insert at the caret position.



Keyboard
Shortcuts          Special Characters

Shortcuts
F1 Help
F2 Change Autotext shortcut to text.
F3 Insert siglum
F5 Insert reference into apparatus
F6 Synchronize windows
F7 Insert reference to current line into apparatus at current position there
F8 Refresh the windows of the current document
F9 Update reference

Shift + F3 Solve the sigla of the manuscript numbers / sigla block right to the caret to 
manuscript numbers

Shift + F5 Insert reference into notes
Shift + F6 Tile open windows
Shift + F7 Insert reference to current line into notes at current position there
Shift + F9 Search dirty reference

Ctrl + F2 Define Autotext shortcut for marked text.
Ctrl + F3 Build the manuscript numbers / sigla block right to the caret to sigla

Shift + Ctrl + F9 Updates the current object (Windows 95/NT only)

Shift + Insert Edit | Paste
Shift + Delete Edit | Cut

Alt + Backspace Edit | Undo

Ctrl + # Insert command string
Ctrl + 1-4 Go to bookmark 1, 2, 3 or 4
Ctrl + A Windows | Apparatus
Ctrl + C Edit | Copy
Ctrl + D Set font to the default font of the paragraph
Ctrl + F Find | Find
Ctrl + G Find | Find sigla
Ctrl + M Find | Find mss.
Ctrl + N Windows | Notes
Ctrl + O File | Open
Ctrl + P File | Print
Ctrl + R Find | Replace
Ctrl + S File | Save
Ctrl + T Windows | Text
Ctrl + V Edit | Paste
Ctrl + X Edit | Cut
Ctrl + Z Edit | Undo
Ctrl + Backspace If MultiKey is installed, only the diacritical mark on a character gets deleted.
Ctrl + Insert Edit | Copy
Ctrl + Delete Edit | Delete reference

Shift + Ctrl + 0 Options | Show control signs
Shift + Ctrl + 1-4 Set bookmark 1, 2, 3 or 4



Shift + Ctrl + A Input font name
Shift + Ctrl + B Bold
Shift + Ctrl + F Find | Find again
Shift + Ctrl + G Find | Find sigla again
Shift + Ctrl + I Italic
Shift + Ctrl + L Right to left
Shift + Ctrl + M Find | Find mss. again
Shift + Ctrl + P Input font size
Shift + Ctrl + R Find | Replace again
Shift + Ctrl + S Strikeout
Shift + Ctrl + U Underline
Shift + Ctrl + X Hidden
Shift + Ctrl + Z Enter window zoom factor (Windows|Zoom|Other)

(Shift +) Ctrl + E Show whole reference (show first and last word only)
(Shift +) Ctrl + H Hide (show) reference
(Shift +) Ctrl + Q Insert (remove) bracket ("]")

Special Characters
Tab Sets a position to insert superfluous space when block-aligning a line.
Shift + Tab Marks the character left to the caret position as not to be printed at line ends.

Ctrl + Space protected space (does not break)
Shift + Ctrl + Space protected hard space (does not break and will not be expanded on block-align)
Shift + Return Location where line end is possible
Ctrl + Return line break
Ctrl + “-” syllable division
Shift + Ctrl + “-” not-protected dash (simple dashes won't break a word at line-end)

Alt + 0-9 Insert numerals that will not be treated as mss. into an apparatus window



Use, Find and Replace Special Characters
Use the following codes in the Find What and Replace With fields or to enter the strings to be inserted 
into notes and apparatus on printing.

^l line break
^p paragraph sign
^s protected space (does not break)
^. protected hard space (does not break and will not be expanded on block-align)
^- syllable division
^_ not-protected dash (which may break the word at line-end)
^= position to insert superfluous space when block-aligning the line
^# sign that marks the previous character not to be printed at line ends
^! location where line end is possible
^^ caret sign (^)

Section divisions are part of paragraph marks. So when replacing paragraph signs be careful not to 
unwillingly delete section divisions.



Open File Dialog Box
Menu: File | Open.

This dialog box lets you open an existing Classical Text Editor document. The default extension is *.CTE.



Import File Dialog Box
Menu: File | Import.

This dialog box lets you import files from ENPS or RTF. Choose the desired file type in the file type 
combo-box (You have to do so even if you enter a file name with extension to inform the program, which 
type of file to convert!).
ENPS Choose an ENPS configuration file. You will specify the number of the text in a following 

dialog box.
RTF Choose a file in Rich Text Format (ANSI or Macintosh character set).



Import Format Dialog Box
Menu: Options | Import | Format.

This dialog box lets you import the formats of a different document into the active document. The 
corresponding formats in the active document will be overwritten.



Import Sigla Dialog Box
Menu: Options | Import | Sigla.

This dialog box lets you import the sigla of a different document into the active document. The sigla in the 
active document will not be overwritten. Instead, the imported sigla will be appended to the existing list. 
Virtual double assignments won't matter, because the imported sigla are assigned an internal ID of their 
own. Delete unwanted old or new sigla manually.



Insert File Dialog Box
Menu: Insert | File.

This dialog box lets you insert another Classical Text Editor document into the current document at the 
current position.



Save As Dialog Box
Menu: File | Save as.

This dialog box lets you save the current document under a new name.



Save Index Dialog Box
This dialog box lets you choose the name and location of the index you are going to build.



Find Dialog Box
Menu: Find | Find.

This dialog box lets you search for text and formats.
You can search for special characters.
You may use the keyboard shortcuts, the Paragraph and Font buttons or the toolbar to enter formats (All 
toolbar formatting commands will be directed to this window when it is open). The Plain button deletes all 
format settings.
You may cancel a lengthy search by pressing the Esc key.
You may confine the search to a part of the text by selecting that part before opening this dialog box.



Replace Dialog Box
Menu: Find | Replace.

This dialog box lets you search for and replace text and formats.
If you specify no replace string but a replace format, all found text will be re-formatted.
If you specify neither a replace string nor a replace format, all found text will be deleted.
You can search for special characters.
You may use the keyboard shortcuts, the Paragraph and Font buttons or the toolbar to enter formats (All 
toolbar formatting commands will be directed to this window when it is open). The Plain button deletes all 
format settings.
You may cancel a lengthy search or replace operation by pressing the Esc key.
You may confine the search and replace operation to a part of the text by selecting that part before 
opening this dialog box.

Warning: When replacing formats in the notes and apparatus windows, you may delete whole 
entries without further request.
Undo will not restore most of the changes of a global replace command. So if you are not 
quite sure what you are doing, save your document prior to any essential changes so you
will later be able to close your document unsaved and reopen it if something went wrong.



Font Dialog Box
Menu: Edit | Font.

This dialog box lets you change the current font, font size and font attributes.
Empty fields and grayed checkboxes indicate, that default values are to be used, which will in most cases 
be those of the paragraph's default font. White checkboxes indicate, that the item is definitely unselected. 
This is useful for searching characters for unselecting a font style which is selected in the corresponding 
default font.

Font
Lets you enter the name of the desired font.

Font Style
Lets you enter font styles like italic or bold.

Size
Lets you enter the size of the font (in points, you may use one decimal).

Strikeout
Lets you create strikeout characters.

Underline
Lets you create underlined characters.

Capitals
Converts lowercase to uppercase characters (without affecting the character size).

Hidden
Lets you create hidden characters.

Position
Lets you define the position of the characters relative to the line (in points, you may use one decimal). 
Negative values will result in superior characters.

Spacing
Lest you produce wide or low spaced characters. The distance to the following character will be affected.

Right-to-Left
Lets you define right-to-left text.

Not Italic
Lets you define a font as definitely not italic. This is useful for searching characters or if the corresponding
default font is italic.

Not Bold
Lets you define a font as definitely not bold. This is useful for searching characters or if the corresponding
default font is bold.



Preferences Dialog Box
Menu: Options | Preferences.

This dialog box lets you set general preferences.

You may select the colors used by Classical Text Editor to distinguish different types of text. Hidden text is
marked through the text color, all other types through the background color.

Kerning
Many True Type™ Fonts include kerning data. This options let you specify how the Classical Text Editor 
uses them.

Min. Font Size
Specify the minimum font size with which kerning shall be used. Kerning will occur only on fonts whose 
size is equal to or exceeds this number. Specifying a number higher than any font used in a document will
virtually disable kerned printing.

Use on Screen
You may disable kerning to appear on your screen for two reasons:
) Screen output may be slowed down markedly due to the processing of kerning-pairs.
) Kerned characters may be partially overwritten.
Disable this option to avoid these problems (the screen output of kerned fonts may become more than 
double as fast).

Auto MultiKey
If this option is selected and MultiKey is installed on your system, your keyboard mode will change 
automatically according to the current font. Diacritical marks can be added to each character without 
having to delete and re-enter the character first.

Draw Objects
If checked, linked and embedded objects will be drawn as they will be printed.
Uncheck this option if drawing all objects slows down your system.



Format Dialog Box
Menu: Options | Format.

This dialog box lets you specify the settings of the active document. All measures are cm.

Page

Header
Distance from the page top to the header.

Top
Distance from the page top to the top of the text.

Bottom
Distance from the page top to the bottom of the text.

Footer
Distance from the page top to the footer.

Mirror
If checked, even and odd pages will be mirrored.

Widow Ctrl.
Turns the widow control on or off. If checked, pages won't end with the first nor begin with the last line of a
paragraph.

Line Numbers
Gives the format of the line numbering. You can define one numbering for each margin. The format is:

<O/I><C/P><number>[,<O/I><C/P><number>][,W]
O Line numbers on the outer (right) margin
I Line numbers on the inner (left) margin
C Line number according to chapters (which will reflect the numbers used for references in the 

apparatus
P Line numbers according to the page
W Print line numbers according to the page through the whole page (i.e., for notes, too)

Every <number>th line will be numbered.

Margin Sep.
Enter the character that will separate two margin texts that belong to the same line of text.

Page Number
Here you set the coordinates of the page number (from left top), its alignment and its font

Templates

Template
Choose the paragraph template which you want to edit. Predefined templates are Text, Header, Inner 
Margin, Outer Margin, and one for each notes / apparatus.

Add
Adds a new paragraph template. Before pressing this button, type the name of the new template into the 



Paragraphs combo-box. This name has to be unique and not to start with the string “Notes” or 
“Apparatus”. The format of the newly created template will be initialized with the settings of the last 
selected existing template.

Delete
Delete the active template.

Paragraph
Edit the paragraph settings of the active template.

Settings
Edit the note / apparatus settings of the active template.

Notes

Number of Notes / Apparatus
The number of notes / apparatus currently in use. Change this item by clicking on the arrows right to the 
number and confirming your choice in the dialog box to appear then. If you decrease the number, the 
highest notes / apparatus will be lost immediately and will not be able to be recovered later.

Order
The order in which the notes and apparatus are to be printed. For each note ore apparatus, type a N or A 
followed by the number. E.g. the string “N2A1” causes the second notes to be printed before the first 
apparatus, and therefore the first notes (and all subsequent notes and apparatus if defined) are skipped.

Before Notes Min.
Minimum space between the bottom of the text and the first line of the first notes / apparatus.

Between Notes Min.
Minimum space between single notes / apparatus.

Break if Free
If the specified amount of vertical page space would be unused, it will be tried to break some apparatus 
entries to the following page in order to print an additional line of text.

Print Notes
The method according to which free vertical space on the page will be distributed:
Top The notes / apparatus follow immediately below the text.
Bottom The notes / apparatus are printed on bottom of the page.
Equal Free space is distributed evenly between the text and the single notes / apparatus.

Standard
Makes the actual settings default for all new documents.



Paragraph Dialog Box
Menu: Edit | Paragraph.

This dialog box lets you change the attributes of the current paragraph. All measures are cm if not 
mentioned otherwise.
In order to produce optimal mirroring, the paragraph margins are given relative to a bounding rectangle 
that can be mirrored on odd pages.

From Margin
Distance between the inner (left) margin of the page and the bounding rectangle.

Bounding Width
Width of the bounding rectangle.

Left
Distance from the left margin of the bounding rectangle to the left margin of the text.

Right
Distance from the left margin of the bounding rectangle to the right margin of the text.

Indent
Indent of a paragraph's first line.

Align
Alignment of the text.

Before
Additional space before a paragraph (in points).

After
Additional space after a paragraph (in points).

Line
Line spacing (in points).
If you don't want the line spacing to increase to give room to a larger font, check the Exactly check box. 
Otherwise the given value is interpreted as the minimum line spacing.
If you want the line spacing to follow the font heights, enter the value 1 and uncheck the Exactly check 
box.

Font
The paragraph's default font.

Page Break
If checked, the page will be broken at the bottom of the paragraph.



Notes / Apparatus Settings Dialog Box
Menu: Options | Format, "Templates", "Settings".

This dialog box lets you change the settings for notes or apparatus. All measures are in cm if not 
mentioned otherwise. Changes concerning the shape of references will not show up immediately but the 
next time the references get updated (to do so, choose Update All References from the Edit menu).

Style
Text Reference
References will be indicated by repeating the referenced words in the notes. This is the default setting for 
critical apparatus.

Footnote numbers
References will be indicated through numbered footnotes. The numbers and number styles (1, i, I, a, A) 
can be chosen for every individual note by executing Reference from the Edit menu when the caret is in 
the text window.

Separator Line
Choose the width of the separator line printed above the notes / apparatus (0.0mm for no line).

Above
Distance between the separator line and the notes / apparatus text (in points).
Left
Distance from the left margin of the bounding rectangle to the left margin of the separator line.
Right
Distance from the left margin of the bounding rectangle to the right margin of the separator line.

Strings
In the following five fields you may use special control characters.

End of Reference
Characters to be printed after each entry of the notes / apparatus.

Between References
Characters to be printed as separators between single entries.

Between Lines
Characters to be printed as separators when the entries to a new line begin.
E. g., if you enter "^s^=|^#^= " (without the quotation marks), the entries to single lines will be separated 
by a | character, positioned exactly the middle of the free space. All available free space in the printed line
will be assigned to these locations, and the | character will not be printed if it came to stand at the end of 
a line.

After Line Number
Characters to be printed between the line number and the entries for that line.

From…To
Characters used in references as indicator for an omission.

Fonts
Use the text font for references



If checked, the default font of the text window as well as its right-to-left style (but not any other style) will 
be used for the words referencing the text. All other text, as line numbers, indices and brackets, will 
appear in the font of the apparatus itself.

Indices
Font of the index numbers used in references.

Line Nrs.
Font of the line numbers (used on printing).

Footnotes in Text
Font of the footnote numbers as they will appear in the text.

Footnotes in Notes
Font of the footnote numbers as they will appear in the notes.

Print
None
Neither chapter nor lines will be printed in the apparatus. That is, you will have to provide all reference 
information yourself. Use this function if you intend to use a given verse numbering in prose text (as in the
bible). You may then specify the verse number manually in the first entry to each verse or specify a 
chapter text for each verse and use the following setting. The later procedure may be automatized, if 
every verse is contained in a paragraph of its own.

Chapter
Chapters, but not line numbers will be printed in the apparatus. You will use this choice if you edit a text 
consisting of metrical lines, some of which break into the next line, which renders numbering the lines 
actual lines not useful. You will then define a chapter text for each verse and indicate the line numbers as 
margin text using automatic paragraph numbering.

Chapter and Line
Chapters and line numbers will show up in the apparatus automatically. This will be the usual choice, 
fitting for most prose texts, which have no widely recognized verse numbering.

Mss. List
If checked, this apparatus will serve as a manuscript indicator. That includes, that any text preceding the 
first reference entry will be treated as information of mss. presence and will not be printed. If this option is 
not checked, the text preceding the first reference entry will be printed in the apparatus.

" " betw. Sigla
If checked, spaces will be inserted when automatically building adjacent sigla.

¶ on Page Break
If this option is checked and a page contains notes continued from the previous page, the notes for the 
current page will start with a new paragraph.



Section Dialog Box
Menu: Edit | Section.

This dialog box lets you change the attributes of the current section.

Begin With
Choose whether the section shall begin without page break or on the next / next odd / next even page.

On First Page
Choose whether the first page of the section shall have a header / a footer / a page number.

Page Number
Choose the desired type of page numbering.
Continue Continue the page numbering from the last section (default)
Begin with Start this section with a new page number.
Step If "2" is selected, only odd or only even pages will be printed, depending on the "Begin 

with" value.



Insert Chapter Reference Dialog Box
Menu: Insert | Apparatus reference (from header and footer window).

This dialog box lets you select which chapter reference you want to insert into a header or footer.

From
Choose which chapter to print first (The “Even” options apply only to odd headers!).

To Last Chapter on Page
If checked, the first and last chapter will be printed.

"To"
Characters to insert between the “first” and the “last” reference.

Line Numbers
If checked, line numbers will be appended to the chapter references (Not useful with the “First Chapter” 
options!).



Insert Siglum Dialog Box
Menu: Insert | Siglum.

This dialog box lets you choose a siglum to insert.
Highlight a siglum with the arrow keys or the mouse and press the Return key, or double-click a siglum. 
The siglum will be inserted into the active apparatus window on the caret position.
You may select more than one siglum by holding down the Shift or Ctrl key while selecting items.



Edit Sigla Dialog Box
Menu: Options | Sigla.

This dialog box lets you add sigla to your document or change existing sigla. Existing sigla can only be 
deleted or their mss. changed when all sigla in the document are resolved (use the menu command Edit | 
Solve Sigla).

Siglum
Lets you choose a siglum to edit.

Text
The characters of the siglum. The first part must be separated from the second part by a space.

Font
Lets you change the font of the first part of a siglum. Only the font name, the italic, bold, not italic and not 
bold styles can be specified.

Index
Here you specify the relative font size and position of the second part of the siglum.
Rel. Size A percental value between 50 and 100, denoting the relation of the font size of the siglum's 

second part to the standard apparatus font.
Rel. Pos. A percental value between -100 and 100, denoting the position siglum's second part in 

percent of the standard font height.

E.g. if the standard font height of an apparatus is 10 pt., values of 80 and -30 would cause the siglum's 
second part to appear in 8 pt. and 3 pt higher.

Want
A number between 51 and 100 that specifies how many of the siglum's mss. must actually be present that
the siglum will be used. Missing mss. will be printed in round brackets with a minus sign preceding.

Mss.
The Siglum's mss. as a mss. list.

Apply
Apply the changes you made to the highlighted siglum.

Up / Down
Lets you change the order of the sigla: Choose a siglum and press the appropriate key to move it.

New
Add a new siglum. Enter the new siglum's mss. immediately after creating it and before activating another
siglum!

Delete
Delete the highlighted siglum.



About Dialog Box
Menu: Help | About.

This dialog box shows you version and registration information and lets you register your copy of 
Classical Text Editor by clicking the Register button.



MultiKey Font Dialog Box
Invoke by pressing the MultiKey toolbar button or F12.

This dialog box lets you choose a font from the set of fonts defined for use with MultiKey.
Highlight a font name with the arrow keys or the mouse and press the Return key, or double-click a font 
name. The Keyboard mode appropriate for the chosen font will be activated.



Registration Dialog Box
You get this dialog box by choosing About from the Help menu and clicking the Register button in the 
About dialog box.
This dialog box lets you enter your registration number and so register your copy of Classical Text Editor. 
The text box with grayed text provides you with the information you need to get a registration number.
Enter your registration number and press the Return key. If the number you typed is valid your name will 
appear in the About dialog box.



Reference Flags Dialog Box
Menu: Edit | Reference (apparatus and notes window).

This dialog box lets you change the attributes of the current reference.

Visible
If unchecked, the reference will be hidden.

Bracket
If checked, a ] bracket is inserted after the reference.

Print All
If checked, the reference, if not too long, will be given in full. If unchecked, the first and last word only are 
used. 

If you select a bracket but deselect visible, the reference will remain visible and have a bracket, but no 
space after it.



Zoom Dialog Box
Menu: Window | Zoom.

This dialog box lets you choose the zoom factor in % for the current window.
Enter a number between 40 and 1000.



Delete Mss. Dialog Box
Menu: Find | Delete mss.

This dialog box lets you delete no longer wanted mss. from the current document.

Mss. to Delete
Enter the unwanted mss. as a mss. list.



Find Mss. Dialog Box
Menu: Find | Find mss.

This dialog box lets you search for mss. constellations.
You may confine the search to a part of the text by selecting that part before opening this dialog box.

Find Which Mss.
Enter the mss. to search for as a mss. list.

Where Not
Enter mss. that shall not be present in the found manuscript numbers / sigla blocks as a mss. list.



Find Sigla Dialog Box
Menu: Find | Find sigla

This dialog box lets you search for sigla constellations. All sigla / manuscript number blocks will be found, 
in which the mss. appear that belong to the specified sigla, regardless if the sigla are actually built. 
Because sigla are a feature of the document, this is a modal dialog box to prevent you from switching to 
other windows. If you want to search for the same mss. constellation in different documents, use the Find 
Mss. Dialog. Nevertheless, the specified mss. (not sigla) are shared between both concepts.
You may confine the search to a part of the text by selecting that part before opening this dialog box.

Find Which:

List box
Select the sigla to search for.

Edit field
Enter the mss. to search for as a mss. list.

Where Not:

List box
Select the sigla that shall not be present in the found sigla / ms. numbers blocks.

Edit field
Enter mss. as a mss. list that shall not be present in the found sigla / ms. numbers blocks.

Clear Selection
Clears the selection of the list box that is currently visible.

All mss.
If checked, only the sigla / ms. numbers blocks will be found that contain all mss. belonging to a specified 
siglum. Otherwise, not all mss. need to be present, according to the single siglum's "Want" number.

Edit Sigla
Opens the Edit Sigla Dialog Box



Insert Character Dialog Box
Menu: Insert | Special character.

This dialog box lets you choose a special character to insert into your document. For each of the 
characters exists a keyboard shortcut, too. Some of these characters are visible only if you have selected 
Show control signs in the  Options menu.

Protected Space
Inserts a space that will not break the line.

Protected Hard Space
Inserts a space that will neither break the line nor be expanded on block-align.

Syllable Division
Inserts a syllable division sign.

Not Protected Dash
Inserts a short dash that may break the word at line-end (simple dashes won't).

Block-Align Space
Marks the current position for inserting superfluous space when block-aligning a line.

Possible Line End
Thus you may specify a where the line may break in the middle of a word without dash.

Don't Print Prev. Char at End of Line
Marks the previous character not to be printed on line ends.

N-Dash
Inserts an n-dash.

M-Dash
Inserts an m-dash.



Edit Autotext Dialog Box
Menu: Options | Autotext.

This dialog box lets you view and edit your Autotext shortcuts.

Autotext
Select the Autotext shortcut to modify or delete.

Modify
Modify the shortcut for the specified text.

Delete
Delete the selected Autotext entry.



Character Map
Menu: Insert | Character map.

This dialog box lets you choose characters from the current font. Double-click a character to be inserted 
in your document, or highlight it and press the return key.



Import Bible Works Text Dialog Box
Menu: Insert | Bible Works text.

This dialog lets you import Greek and Hebrew Bible Works texts by converting them to WinGreek 
convention or inverting the position of the masoretic signs respectively.

Choose the language to use and paste the Bible Works text to the edit field using either the clipboard or 
using the Bible Works "Popup Verse Retriever". When you press the OK button, the text will be converted 
and inserted into the document at the caret position.

The text will appear in the current font, so maybe you will have to mark it and convert it to the desired font
using the toolbar or the font dialog box.



Scale Object Dialog Box (Windows 95/NT only)
Menu: Object | Scale.

Width
Enter the desired width of the object in cm or in % of the original width.

Height
Enter the desired height of the object in cm or in % of the original height.

Scale isotropic
If checked, width and height of the object are changed accordingly to each other.

Original
Use the original size of the object.



Footnote Style Dialog Box
Menu: Edit | Reference (text window)

Character
Specify a character to show up in this individual footnote instead of the number.

Number
Specify the number from which the footnotes shall (re)start (from the current footnote on).

Style
Specify the number style for the current and the following footnotes.



Paragraph Numbering Dialog Box
Menu: Insert | Paragraph numbers.

This dialog box lets you number your paragraphs automatically and insert chapter and margin text 
accordingly.

Action
Add Numbers
Add new numbers to each paragraph.

Delete All!
Delete the first entries in each paragraph.

Scope
From Caret to End
Performs the selected action beginning with the paragraph in which the caret is positioned until the end of
the document.

Next n Paragraphs, n=
Performs the selected action beginning with the paragraph in which the caret is positioned for n 
paragraphs. Enter the number of paragraphs in the edit field right to the radio button.

Format
Begin with Number
First number to be used.

Chapter
If checked, chapter text will be inserted for each paragraph.

Inner Margin
If checked, inner margin text will be inserted for each paragraph.

Outer Margin
If checked, outer margin text will be inserted for each paragraph.

Text
Enter the text you want to appear as chapter or margin text. Question marks ("?") will be replaced by the 
chapter number. You may use special characters.

Add
If you want text to follow after the chapter text which does not belong to the chapter text (i.e. which will not
be used for references in notes, apparatus, header or footer), enter it here. You may use special 
characters.

Step
When inserting margin text, you may specify in which steps the number shall appear. E.g., if you specify 
"5", the margin text will be inserted only in paragraphs whose number is a multiple of 5.



Index Dialog Box
See also:          Indices

Menu: File | Index.

This dialog box lets you export indices.

Part
Choose for which part of the text (text, notes, apparatus) you want to set the values.

Enabled
If checked, the current part of the text will be skipped.

Complete
Lets you create an index comprising every word of the text. This kind of index is compatible with Index 0, 
that is, you may build an complete index of some parts of the text (e.g. the text itself) including the 
predefined index 0 entries of other parts (e.g. the notes).

All Words
Include all words of the current part of the text but not the index 0 entries.

Index 0
Include just the index 0 entries.

Both
Include all words plus the index 0 entries.

Exclude
Chapter
If checked, words contained in chapter text will be skipped.

Hidden Text
If checked, words contained in hidden text will be skipped.

Inner Margin
If checked, the inner margin text will not be included in the index.

Outer Margin
If checked, the outer margin text will not be included in the index.

Entries
Lets you create indices from predefined entries.

Index Nr.
Enter the number of the index you want to build.

Index
Start building the index. You will be asked the name and location of the textfile which will contain the 
index.



Import ENPS File Dialog Box
Menu: File | Import, File type: "ENPS configuration".

This dialog box lets you specify the ENPS text to convert together with some conversion options.

Text Number
Enter the number of the ENPS file you want to convert. The text will be specified through this number and
the settings in the ENPS configuration file you opened.

Add Spaces
If checked, spaces will be added after punctuation marks where missing.

Quotations
Here you may specify a font for those parts of text (mostly quotations) that appear between {} brackets in 
the ENPS file.



ENPS
ENPS is a fast DOS-based program used to quickly store text plus variants. It includes facilities for 
working with sigla. Files generated with ENPS can be imported by Classical Text Editor.

Further information



MultiKey
MultiKey is a program designed for facilitating keyboard input under Windows, especially for Eastern 
Europe, Old Greek, Hebrew and Arabian fonts.

MultiKey can be accommodated to provide useful keyboard layout for any font. Is has been designed 
especially for Ancient Greek diacritic marks, but keystroke combinations for other fonts can easily be 
defined. MultiKey supports right-to-left input.

For information not included here, please consult the documentation shipped with MultiKey.

Adjusting MultiKey for Use with Classical Text Editor
You may customize which fonts the MultiKey dialog box will contain and in which order they will show up. 
To do so, open the "MultiKey.ini" file in the Windows directory, and add a new section named "[Alias]". In 
this section, list all fonts you want to show up in the Classical Text Editor MultiKey dialog (as invoked by 
F12), followed by an "=" sign and the name (which for most fonts will be the same). If more than one font 
share the same keyboard layout this procedure enables you to use them all without changing the other 
sections. So, e.g. you might write

[Alias]
Garamond=Times New Roman
Times New Roman=Times New Roman
:

If "Times New Roman" is the MultiKey default font, you will not have to specify aliases for it (especially if 
you use "Auto MultiKey", see below), because the keyboard mode will be set to the default font if there 
are no tables specified for the current font. However, you may decide to include such aliases just to 
access some fonts more easily via the MultiKey dialog.

If Auto MultiKey is activated, the keyboard mode will be adjusted every time you change the font. If not, to
change the keyboard mode, you will have to use the MultiKey dialog (F12), the system menu of the 
MultiKey icon or the MultiKey keyboard shortcuts.

Further information



Rich Text Format (RTF)
The RTF (Rich Text Format) allows to move formatted text between different applications. Most editors 
will export this format. Classical Text Editor can import texts in RTF, but due to restrictions in the RTF 
itself, Classical Text Editor data cannot be re-exported to RTF.



The current reference may be:
In the text window: the first footnote in the selected part of the text, or, if no text is selected, the first 
footnote after the caret.
In any apparatus or notes window: the reference which belongs to the paragraph which contains the 
caret, or any reference between the caret and that reference.



The current object is the first object in the selected part of the text, or, if no text is selected, the first object 
after the caret.



Stefan Hagel
Klosterneuburgerstraße 112/16
A-1200 Vienna
Austria

email: Stefan Hagel <a8601887@unet.univie.ac.at>
Classical Text Editor homepage: <http://www.oeaw.ac.at/kvk/cte/>



Manuscript Listing
An apparatus can serve to keep overview of the manuscripts existing for the current part of the text.
The following standards need to be fulfilled:
1) In a paragraph before the first reference entry list all mss. that start with the beginning of the text 

after a [ sign.
2) Throughout the text, indicate where ms. begin or end in references to the affected words:

[<Mss. numbers> Mss. begin
<Mss. numbers>] Mss. end

3) Activate the Mss. List checkbox in the Settings dialog box for the apparatus.
When printing the apparatus, the mss. that exist for beginning of the page will be listed first.
You can mix this type of entries with other apparatus entries. Nevertheless, it is recommended to use an 
apparatus of its own just for this purpose.



Sigla and Manuscripts
The following refers to apparatus only. What here is called manuscripts, can, of course, be other types of 
text sources, too.
Manuscripts are entered as numbers. So, if you want to use Classical Text Editor's sigla facilities, you will 
first have to number your source texts. Of course, these numbers need not show up in your final printings.
When specifying mss. in an apparatus window, you may give additional information's to any mss. number 
in round brackets after the number. Separate mss. belonging to the same block with commas.
Example: 151, 154 (sic!), 158.
On building sigla this information will be shown in brackets after the siglum, with the specified mss. 
number.
Example: If the siglum "A" is defined as "151, 154", the above string will become

A (sic! 154), 158

If a siglum contains but one ms., the number will be omitted ["A (sic!)" instead of ("A (sic! A)"].
You may use the following specifiers after the ms. number without brackets:

vl., ac., pc., ic. sl. mg.
When building sigla, such expressions will be treated as separate mss., unless defined otherwise in the 
Edit Sigla dialog box, that is,

"151, 154pc." will be built to "A",
- if "A" is defined as "151, 154p" or "151, 154ip",
- but not if "A" is defined as "151, 154".

Defining Sigla
Define sigla and their mss. in the Edit Sigla dialog box. Each ms. can apply to more than one siglum. 
When automatically building sigla, sigla which stand first the list are used first. So if you define the same 
ms. in more than one siglum, it will in most cases be most useful to order the sigla according to the 
number of mss., with the biggest first.
It is also possible to specify a ms. for one siglum, but certain corrections of it in another (See on ms. 
input).
If you don't want to print your document with numbers as ms. identifiers, simply define for each of your 
ms. a siglum of its own, besides and after the sigla for mss. groups.

A Siglum's shape
A siglum consists at least of one ore more characters in a freely definable font (and in the apparatus' 
default style, size and position). Further characters can be appended; they will appear in the apparatus' 
default font, but (relative) size and position are definable. Define the shape of your sigla in the Edit Sigla 
dialog box.

Inserting Sigla into the Document
When in an apparatus window, press F3 or choose Siglum from the Insert menu. The Sigla dialog box will
appear.

Automatically Build Sigla
To (re-)build the sigla / ms. numbers block next right to the cursor, choose Build next block from the Edit | 
Sigla menu.
If you choose Build all from the Edit | Sigla menu, all blocks of mss. in all apparatus windows will be 
scanned and rebuilt using the actual sigla table.

Resolve Sigla
To solve the sigla / ms. numbers block next right to the cursor, choose Solve next block from the Edit | 
Sigla menu.
If you choose Solve all from the Edit | Sigla menu, all sigla in all apparatus windows will be resolved.



Deleting Mss.
When you delete mss. you don't want to use any longer, you can do so automatically by choosing Delete 
Mss. from the Edit menu. The mss. in question will be removed from all sigla for which they were defined 
and all instances of them in all apparatus will be deleted. If in the course of this process an entire mss. 
block gets empty, three exclamation marks are inserted at this place. Search for the string “!!!” to detect 
these cases and to do the necessary cleanup.

Missing Mss.
If for any siglum a "Want" value less than 100% is specified, this siglum will be built even when not all 
mss. are present. Missing mss. will be listed in round brackets with a minus sign preceding.
Example: If "A" is defined as "151, 152, 153" with a "Want" of less than 67%,

The block "151, 152" will be built to
"A (-153)"

The list of missing mss. will be scanned for possible sigla, too:
if "B" is defined as "153" (and appears after "A" in the sigla list), the above string will be 
replaced by
"A (-B)"

You may use this format for input, but do not insert spaces before or after the minus sign (If you do so, the
minus sign will be treated as a note to the ms.).

Complex Bracket Expressions
If additional information and missing mss. are mixed, the latter must stand first.
So, given the definition above

"A (-151; pc. 152)" is equivalent (and can be solved to)
"152 (pc.), 153"

Block Format
When automatically building and resolving sigla, individual font formats, such as italics or hidden, are 
naturally lost. The whole block will receive the format of the space character preceding it. Additional 
information in brackets (other than excluded ms.) will retain its formats, except if these are equal to the 
paragraph format of the apparatus. So e. g. if the apparatus paragraph format is set to "not bold" and any 
portion of text in brackets is formatted as "not bold", this text is formatted like the whole block when built 
automatically. That is, if the whole block becomes bold, the formatted text will become bold, too. To retain 
the text not bold even if the whole block becomes bold, turn the "not bold" option of the apparatus 
paragraph format off.

See also: Mss. Listing



Manuscript List Input
When entering a list of manuscripts in an edit field of a dialog box, just type a list of numbers separated by
commas or spaces. If you want to denote not the ms. itself but a certain corrector or so, enter one or more
of the following characters, which resemble abbreviations in the apparatus text, immediately after the 
number:

v varia lectio vl.
a ante correctionem ac.
p post coorectionem pc.
c inter correctiones ic.
s supra lineam sl.
m in margine mg.
i This character denotes the pure number and may be specified in combination with the 

characters above.
When building and resolving the sigla automatically, the abbreviations listed above to the right will be 
inserted in italics after the ms. number.
Note that if more than one character is specified, information will get lost when building the siglum: On 
resolving, the specified character which is first in the above list will be used. If an "i" is specified, too, the 
pure number will be restored. Use such combinations only where specific information need not be 
preserved or shall explicitly be removed.
a) "A" is defined as "150sm"

"150mg." will be built to "A" and this resolved to "150sl." --- Not really useful.
b) "A" is defined as "150im"

"150mg." will be built to "A" and this resolved to "150" --- Could be useful.

There exists an alternative method, which lets you both specify corrections and build ms. to sigla without 
loosing information: When editing the apparatus, add the abbreviations in round brackets following the 
ms. number: "150 (vl.)". Now this ms. will apply to all sigla which include ms. "151", and the additional 
information will be added to the siglum: "A (vl. 150)". See Sigla and Manuscripts.



Autotext
To create a Autotext shortcut for a certain text, mark this text and choose "Create Autotext" from the "Edit"
menu. You will be requested to specify the shortcut to be associated with the text.

To retrieve the text, type the associated shortcut and choose "Autotext" from the "Insert" menu or press 
"F2". The shortcut will be replaced by the text, including all formats.

To edit or delete Autotext shortcuts, choose "Autotext" from the "Options" menu.



Mss. numbers / Sigla Blocks
A mss./sigla block consist of one or more ms. numbers and / or sigla, terminated by a semicolon, colon, 
period, square bracket, closed round bracket or a paragraph end. Numbers have to be separated by a 
comma.

Example: AF1Y 151, 152ac., 153.



Indices
Classical Text Editor supports the creation of two types of indices. Referencing will accord to page and 
line number so that references to the apparatus are possible, too.

If you just want an index comprising every word of the text (and maybe of some notes), just invoke the 
Index dialog (menu command: File | Index) and proceed with the Complete option.

If you want but some words or lemmata indexed, you will first have to define them. To do so, insert a 
command string (Menu command: Insert | Command string) at the appropriate position in the text. The 
string should follow this format:

i<number>:<text>

where <number> is the number of the index, and <text> the text to be indexed. Giving no number is 
equivalent to giving zero. Note that the zero index may be mixed with the complete index, see the Index 
dialog. Create the indices using the Index dialog (see above) with the Entries option.

All indices will be sorted according to standard rules and saved as text files. You may use any word-
processor or database program to edit, format or resort the indices.



Registration
Order licenses from the author of Classical Text Editor. Include the exact name and organization, 
including dashes, periods etc., to which your copy of Windows is registered. You will obtain this 
information by opening the About dialog by choosing About from the Help menu. Then click on the 
Register button to open the Registration dialog. The text box in the middle of this dialog contains the 
relevant strings.
You will receive a registration number referring to these strings. Register your copy of Classical Text 
Editor by entering this number in the Registration dialog (see above). Your name should then show up in 
the About dialog box.
If you (and only you) use Classical Text Editor on more than one computer, include the strings of all 
involved systems.



Right-to-Left Text
See also: MultiKey

The Classical Text Editor supports right-to-left text, that is you may use right-to-left text exclusively or 
mixed with standard text.
To format text as right-to-left, invoke the Font dialog box from the Edit menu.
If you format a whole paragraph as right-to-left, you will presumably justify it as "Right" or "Right Block". 
To do so, invoke the paragraph dialog box from the Edit menu.
If you use blocks of right-to-left text within left-to-right text, make it sure that the spaces surrounding the 
right-to-left text are formatted as left-to-right. Otherwise the text will not get justified correctly.
The caret keys, as well as the backspace and the delete key, work according to as the text is read.

Restrictions and Odds
It is not possible to use blocks of left-to-right text within right-to-left text.
While entering right-to-left text, the caret will remain before the next character (as usual), that is, if the 
caret is followed by left-to-right text, it will remain at the virtual "beginning" of the right-to left block.
It will not be possible to position the caret correctly by clicking at right-to-left text which is preceded by    
left-to-right text in the same line.
Strange things will happen if differently running text is marked at the same time. In this case, do not rely 
on the color inversion to know what is marked and what not. Use the arrow keys and be precise!



COPYRIGHT NOTICE
"Classical Text Editor" Copyright © 1997/98 by Stefan Hagel. All rights reserved.
"CTE Hebrew" TrueType™ font is derived from BWHEBB from BibleWorks™ for Windows™ and 
therefore Copyright © 1994-1997 Michael S. Bushell. All rights reserved.
You may distribute the files coming with the Classical Text Editor as a whole if you do not change any part
of them. You may not sell this product or any part of it.

And now to the usual

WARRANTY DISCLAIMER
This software and the accompanying files are distributed and sold "as is" and without warranties as to 
performance or merchantability or any other warranties whether expressed or implied.
Good data processing procedure dictates that any program be thoroughly tested with non-critical data 
before relying on it.    The user must assume the entire risk of using the program.
ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR
REFUND OF PURCHASE PRICE.

Stefan Hagel




